
 

 

Getting Started with Mplus Version 8.1 Demo for Mac OS X and Linux  

This document shows how to install Mplus Demo, how to use Mplus Demo, and where to find additional 

documentation.  

Overview  

Mplus Version 8.1 Demo is available for 64-bit Mac OS X and 64-bit Linux operating systems.  Mplus 

Demo for Mac OS X is available with the Mplus Editor.  Mplus Demo for Linux operating systems is 

available only from the command line.  Plot information produced by Mplus Demo can be read and plots 

made by the R program using the HDF5 package.  

Installation  

Installation on Mac OS X  

Installation of Mplus Demo on Mac OS X runs in GUI mode.  The default installation location is the 

/Applications/MplusDemo folder.  

Installation on Linux  

Installation of Mplus on Linux operating systems runs in console mode by default.  The installer can also 

be run in GUI or silent mode.  To run the installer in GUI or silent mode, use the -i option as shown 

below:  

• For GUI mode:  install_mplus -i gui  

• For silent mode:  install_mplus -i silent  

Note that installation in GUI mode requires that a Java virtual machine is installed.  A Java VM pack is 

bundled with the installer but may not be compatible with certain Linux operating systems or computer 

architectures.  

For all installations, the default installation directory is /opt/mplusdemo.  Installing Mplus into the /opt 

directory requires root permissions.  If this is the desired installation directory, execute the installer as 

root or with sudo.  

Environment Variables Set During Installation  

The Mplus installation sets the following environment variables:  PATH and TMPDIR.  The PATH 

environment variable is required in order to refer to the Mplus executable without giving the full path of 

the installation directory.  Mplus creates all temporary files in the directory pointed to by the TMPDIR 

environment variable.  By default, the TMPDIR environment variable is set to the /tmp directory.  

If the installer is executed as root or with sudo, then the installer will add the commands to set the 

environment variables to the system file /etc/profile for bash shell and /etc/.login for C shell.  If the 



 

 

installer is executed without root permissions, then either the file .profile (for bash shell) or .cshrc (for C 

shell) is updated with the new settings for the PATH and TMPDIR environment variables.  

The following table summarizes these settings:  

Running installer...  as root or with sudo  as non-root  

For Bash shell  /etc/profile /etc/.login  .profile  

For C shell  .cshrc  

  

Since the settings of these files are only applied during the login process, sourcing the specific file or 

relogging in will apply the settings to any opened sessions.  

The typical Mplus installation installs the Mplus executable file, the Mplus User's Guide in PDF format in 

the Documentation directory, and examples from the Mplus User's Guide in the Examples directory.  

When disk space is limited, install Mplus with the minimal option which will install all files except the 

Mplus examples.  This option can be selected after running the Mplus installer.  

Uninstalling Mplus  

To uninstall Mplus, execute the uninstall_mplus command in the uninstall directory in the Mplus 

installation directory.  Note that if root permissions were used when installing Mplus, then the same 

permissions are required for uninstalling Mplus.  

Running Mplus  

Running Mplus on Mac OS X  

Start the Mplus Editor for Mac OS X.  The Mplus Editor can be found in the /Applications/MplusDemo 

folder.  Create a new file by using the New option under the File menu or open an existing file by using 

the Open option under the File menu.  To run Mplus, click on the Run button.  The Mplus output file will 

be created in the folder where the input resides.  When the Mplus run finishes, the output file will be 

opened in the Mplus Editor automatically.  

The Mplus Editor features keyword highlighting of the Mplus commands.  

For information on how to use Mplus from the command line on Mac OS X, please refer to the tutorial 

for using Mplus on Mac OS X on the Mplus website at www.statmodel.com/mactutorial.shtml.  

Running Mplus from the Command Line on Linux  

Mplus Version 8.1 Demo is available for Linux operating systems from the command line.  

Following are steps to use Mplus from the command line:  

1. Open a command prompt.  

http://www.statmodel.com/mactutorial.shtml
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2. Set the environment variables for Mplus (if not already set).  

3. Run Mplus.  

To run Mplus, type the following at the prompt mpdemo 

<name-of-input-file>  

substituting <name-of-input-file> with the name of the text file containing Mplus instructions that you 

wish to run.  An output file with the same name as the input file but with the OUT extension will be 

created in this directory.  The input files for the examples from the Mplus User's Guide have the 

extension INP.  Mplus input files can be edited using any text editor.    

Environment Variables for Mplus  

Mplus uses the following environment variables.  For instructions on setting environment variables, 

refer to the section on Setting Environment Variables.  

If the TMPDIR environment variable is set, then all Mplus temporary files will be created in that 

directory.  If TMPDIR is not set, then some Mplus temporary files will be created in the /tmp folder and 

others will be created in the directory where Mplus is running.  

Other environment variables used by Mplus are:  TERM, COLORTERM, MPLUS_TERM, MPLUS_TERM_X, 

and MPLUS_TERM_T.  Please refer to the section about Multiple Processes in Mplus with PROCESSOR 

(STARTS) for more information about how these variables are used.  

Stack Size and Mplus on Linux  

Some Mplus runs may require a bigger stack size than the default stack size.  These runs usually result in 

an incomplete output file and 'segmentation fault' appearing in the command prompt window.  The 

stack size can be increased with the ulimit command in bash shell or the limit command in C shell.  The 

default stack size varies.  To check the stack size, use ulimit -a in bash shell or limit stacksize in C shell.  

Multiple Processes in Mplus with PROCESSOR (STARTS)  

The default terminal program used by the PROCESSOR (STARTS) feature is determined from the setting 

for the TERM environment variable.   

Mac OS X  

On Mac OS X, if the setting for the TERM environment variable is set to xterm or xterm-color, then the 

xterm will be used for the new Mplus processes.  If TERM is not set to either of these settings, then the 

shell command interpreter sh will be used.  This setting will not open a new window and screen printout 

from the Mplus processes will come out in no particular order.  



 

 

The default terminal program for the PROCESSOR STARTS feature can be overridden by setting the 

MPLUS_TERM environment variable.  The setting for MPLUS_TERM should point to the terminal 

program to use.  The MPLUS_TERM_X environment variable must also be set to specify the execute 

option of the terminal program.  The MPLUS_TERM_T environment variable can be set to specify the 

title option of the terminal program.  The MPLUS_TERM_X variable is required if MPLUS_TERM is set;  

the MPLUS_TERM_T variable is optional.  

A special script, called startMplus, is provided in the Mplus installation directory for starting new Mplus 

processes with the Terminal application on Mac OS X.  To use this script, set the MPLUS_TERM variable 

to 'applescript' and both MPLUS_TERM_X and MPLUS_TERM_T to 'startMpus'.  The new Terminal 

windows will not close by default when the new Mplus processes have terminated.  

Linux  

 For Linux operating systems, if the setting is equal to xterm, then xterm will be used.  If TERM is not 

set to xterm, then the shell command interpreter sh will be used.  This setting will not open a new 

window and screen printout from the Mplus processes will come out in no particular order.  

The default terminal program for the PROCESSOR STARTS feature can be overridden by setting the 

MPLUS_TERM environment variable.  The setting for MPLUS_TERM should point to the terminal 

program to use.  The recognized programs are:  gnome-terminal, konsole (for KDE desktops), 

xfce4terminal, and xterm.  For all other terminal programs, the MPLUS_TERM_X environment variable 

must also be set to specify the execute option of the terminal program.  The MPLUS_TERM_T 

environment variable can be set to specify the title option of the terminal program.  The 

MPLUS_TERM_X variable is required if MPLUS_TERM is set;  the MPLUS_TERM_T variable is optional.  

The following table summarizes which terminal programs will be used:  

Environment Variable Settings  Terminal Program Used  

TERM=xterm  Xterm  

TERM=something else  Sh  

TERM not set  Sh  

MPLUS_TERM=gnome-terminal  gnome-terminal  

MPLUS_TERM=xfce4-terminal  xfce4-terminal  

MPLUS_TERM=konsole  Konsole  

MPLUS_TERM=xterm  Xterm  

MPLUS_TERM=something else  

  

(required) MPLUS_TERM_X variable  

(optional) MPLUS_TERM_T variable  



 

 

  

Mplus Plot Capabilities  

Mplus for Mac OS X and Linux operating systems does not come with the plot capabilities provided as 

part of the Mplus Editor for the Windows version of Mplus.  Instead, the GH5 file produced by the PLOT 

command can be read and plots made by the R program using the HDF5 package.  For more information, 

please visit the Mplus-R page on the Mplus website at www.statmodel.com/mplus-R/.  

Setting Environment Variables  

The command and syntax for setting Linux environment variables will be given for the two most popular 

shells which are bash shell and C shell.  For other shells, please consult the man pages for that shell by 

typing 'man shellname'.  

For bash shell:  

• export MPLUS_TERM=xterm  

For C shell:  

• set MPLUS_TERM=xterm  

The commands given above can be entered into .bashrc for bash shell or .cshrc for C shell.  After they 

are added to the .bashrc or .cshrc, the settings will automatically apply every time a new shell is opened 

and need not be set manually.  

Additional Documentation  

The Documentation directory contains the Mplus User's Guide for Version 8 and the Version 8.1 Mplus 

Language Addendum in PDF format.  For Mplus updates, please check the Support page on the Mplus 

website at www.statmodel.com.   Updates to the R functions are available on the Mplus-R page at 

www.statmodel.com/mplus-R/.  

    
Mplus Diagrammer, Version 1.2, May 2014  

The Mplus Diagrammer can be used to draw an input diagram, to view a diagram created from an 

analysis, and to view a diagram created using an input without an analysis. In Version 1, diagrams are 

available for the types of models specified in Chapters 3, 5, and 6 of the Mplus User’s Guide. The 

diagram along with the corresponding input file can be saved for future use. The diagram can be saved 

as a PDF for publication.  

  

Input Diagram  
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The Diagrammer uses a set of drawing tools to draw a diagram.  Once the Diagrammer is opened, the 

input diagram can be drawn using a set of drawing tools that can be accessed via the toolbar, menus, 

and pop-up menus. The toolbar buttons and menu items available for drawing are: Move tool, Draw 

square, Draw circle, Draw factor model, Draw growth model, Draw path, Draw covariance, Draw 

residual, and Add caption. All of the toolbar buttons are shown in the picture below.  

To draw a diagram of a factor model, click on the Draw factor model button or select Draw factor model 

from the Diagram menu and then click on the open page. A prompt for the number of observed 

variables will appear followed by a prompt asking whether default variable names should be used or 

variables names should be entered. If the prompt Enter variable names is selected, a prompt for the 

name of the factor is followed by a prompt for the names of the observed variables. A second factor 

model can be added by clicking again on the page. To move the factor model, right-click on the factor 

circle or on any of the factor indicator squares and choose Select factor/growth model. This activates 

the Move tool. Click on the part of the page where you want the factor model to be placed or drag it 

there. To deselect the factor model, right-click anywhere on the page and select Deselect all. An 

observed variable can be added to the model by clicking on the Draw square button or selecting Draw 

square from the Diagram menu. An arrow can be used to connect the factor to the observed variable by 

clicking on the Draw path button or selecting Draw path from the Diagram menu. When Draw path is 

selected, click on the object from which the arrow originates and pull the arrow head to the object 

where the arrow ends. Click on that object. In addition to the drawing tools, pop-up menus are 

available. Right-clicking on an object or a blank area in the diagram brings up pop-up menus showing all 

available options.  When using a one-button Mac mouse, press the control key while pressing the mouse 

button to bring up the pop-up menus.  The combination of the control key and mouse click is the same 

as a right-click on a two-button mouse.  

  

While a diagram is being drawn on the left-hand side of the screen, the MODEL command is being 

written on the right-hand side of the screen. When the input diagram is complete, the rest of the Mplus 

language can be added to the right-hand side of the screen. The analysis can be run by clicking on the 

RUN button. A file with a dgm extension is created that contains the diagram. The diagram can also be 

saved as a PDF using the Export to PDF option of the FILE menu. To make changes to the diagram after it 

is opened, click on the Input mode menu item of the Diagram menu. This option switches the diagram 

from an output diagram to an input diagram where changes to the diagram can be made. The input file 

is shown on the right-hand side of the screen.  Prior to the analysis, the diagram and input file can be 

saved by using the Save option of the File menu. The file has an mdg extension. It contains both the 

diagram and the input file.  

  

Output Diagram  
  

The Diagrammer can be used to view a diagram created from an analysis. This is the default. For other 

choices, see the Mplus menu in the Mplus Editor. To use the  

Diagrammer to view a diagram, open an input and click on the RUN button. Once the analysis is 

completed, the output diagram will open automatically behind the output file. The diagram can be 

edited using the drawing tools described above. Parameter estimates and standard errors are printed on 



 

 

the diagram as the default. The View menu shows the menu items for changing what is printed on the 

diagram. To edit the diagram, select Input mode from the Diagram menu.  Then select any of the 

drawing tools, for example, Draw path, to change the diagram.  When a change is made to the diagram, 

the corresponding change is made to the input file. If a model contains parameter labels, they can be 

added to the diagram by selecting Show parameter labels from the View menu. A title can be added to 

the diagram by using the Add caption button or menu item. Once the diagram has been changed, go to 

the input file and click on the RUN button to obtain the diagram with the new parameter estimates and 

standard errors.  

  

A file with a dgm extension is created that contains the diagram and the input file. The diagram can also 

be saved as a PDF using the Export to PDF option of the FILE menu. To make changes to the diagram 

after it is opened, click on the Input mode menu item of the Diagram menu. This option switches the 

diagram from an output diagram to an input diagram where changes to the diagram can be made. The 

window on the right-hand side shows the input file.  

  

Diagram From Input  
  

The Diagrammer can be used to view a diagram created using an input without an analysis, with or 

without data. Open an input file and go to the Mplus menu. Select Get diagram without analysis (data) 

or Get diagram without analysis (no data). Then click on the RUN button. Once the input is processed, 

the diagram will be opened behind the output file.  Changes to the diagram can be made in two ways. 

The first way is to open the input file, make changes to the input, and process the input. The second way 

is to edit the diagram and save the changes to the diagram. The diagram can be edited using the 

drawing tools described above. To edit the diagram, select Input mode from the Diagram menu. Then 

select any of the drawing tools, for example, the arrow to change the diagram. If a model contains 

parameter labels, they can be added to the diagram by selecting Show parameter labels from the View 

menu. A title can be added to the diagram by using the Add caption button or menu item. Once the 

diagram has been changed, save the diagram with an mdg extension by using the Save option of the File 

menu.  

  


